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PREFACE 

Introduction 

SIAM is intended for operators who want an easy-to-use data acquisition or automation 

system at laboratory, pilot or small production scale. Depending on the options chosen at 

purchase one can: 

- Configure whichever devices and channels specified at purchase 

- Visualise values of channels or enter personal set points. 

- Save the data from an individual application and edit it with other programs. 

- Visualise data as a graph against time. 

- Set alarms 

- Regulate and modify the set points of channels with different functions  

- Control outflows  

- Keep a log automatically 

- Visualise applications on a systematic diagram. 

- Alternatively, only use the program for data acquisition.  

If the software does not require all the functions described here, applications can be adapted 

according to the requirements.  

If other functions are needed, you can make contact with us. We will integrate the desired 

functions in your software system, in such a way that it conforms optimally to your 

specifications. 

 

Hints 

An automation system should make the work easier. Before initiating the process, think of a 

question: what will happen in the event of a system failure (e.g. an interface, measuring 

apparatus or PC breaking down)? Experimental set up should be made to have a minimal 

effect due to breakdown and the system should be safe. 

For example: 

- Appropriate valves are opened or closed automatically during power cut.  

- Pumps should not be overloaded.  

- Before leaving the program, switch all apparatus to the ñZeroò position. 

- Your equipment must be capable of withstanding the most extreme possible 

conditions placed on it. (Example: For pressure regulation, your apparatus should be 

able to tolerate the maximum pressure allowed by the safety valve). 

- To avoid overheating of electronic circuits, nothing should ever be placed on the D/A 

converter box. 

 

Text convention 

Italic: words which appear in the program, like menu, text on buttons (example: OK) 

 

Supported devices 

The standard version supports the following devices: 

- 6 Lambda MINIFOR fermenters and it can be extended up to 99 



SIAM Industrial Fermentation Software  USER MANUAL 
 

 
www.bioreactors.eu  4 

- 12 Lambda Integrators 

- 6 Lambda Pumps 

- 6 Tecon 350 datalogger  

- 6 Tecon 239  

- 6 Tecon UR5  

- 6 Balances (Mettler, Explorer,é) 

- Much more devices of your choice 

The COM port and the device address are freely configurable. 

If you wish to connect other devices, please contact us either by email (sysmatec@rhone.ch) 

or telephone (+41-27-946-80-18). 

 

INSTALLATION 

To install SIAM (LEA version 5.6) insert the CD-ROM into the CD-ROM drive and start the 

set-up program 'Setup.exe', then install the Dongle. 

Any extension cards that may be required (RS232, RS485, etcé) can then be installed. To 

do this, it is necessary to exit SIAM (Lea version 5.6), shut down Windows and switch the 

computer off. 

If a RS232/RS485 converter is to be used, this can also be connected at this time. Finally 

switch the various devices on, boot the computer and start SIAM (Lea version 5.6). 

 

PROGRAM CONFIGURATION 

This chapter describes the basic configuration of the program and the procedure to generate 

a configuration which can be saved and reopened later. 

Software is provided with an example configuration file based on your requirement. You 

could use it or build your own application. 

 

Synoptic window 

To generate a new window, select the Enter command in the Configuration menu and enter 

the password "lea" in the dialog box. A new entry is then made in the Configuration menu 

and the program is now in configuration mode. 

  

 

mailto:sysmatec@rhone.ch
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To open a new window, select New in the Windows menu. An empty window will be 

displayed in which an application can be built by inserting various elements. 

  

A bitmap image can be imported for use as a background by selecting Import Bitmap in the 

Windows menu. The image can for example represent your experiment. 

  

To rename the window select Rename in the Window menu. To open an existing 

configuration, select Open in the File menu. 
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VISUAL COMPONENT TOOLBAR 

Introduction 

Select Visual Components in the Configuration menu to display the visual components 

toolbar from which components can be selected to place in the synoptic window. This allows 

an application to be built step by step. 

  

  

The toolbar contains several headings: 

Static: these components are linked to small channels or devices. 

Status: these components display the status (on or off) of the digital inputs and outputs. 

Buttons: using these components the state of the digital outputs (on or off) can be changed, 

a channel option window displayed, the calibration of an analogue input carried out, or a link 

between two windows defined. 

Values: these components show the values of analogue inputs and outputs or functions. 

Curves: these components display channel values as curves. 

Devices: these components can simultaneously group several channels from a device in a 

block, together with several basic modules. 

Misc.: components that don't belong under other headings. E.g. to save channel values as 

text files. 

 

Static components 
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Panel: 

Palette button 

 

Display of panel button on the synoptic window 

 

 

Component properties: The component colour can changed. Double click on the surface in 

the colour frame to open a window in which a colour can be selected. 

 

 

Image: 

Palette button 

 

Display of image button on the synoptic window 

 

Component properties: Click on the  button to select an image to display in this object. If 

the configuration is later saved to a file ensure that when reopening it the configuration file 

that the image is still in the same directory. 
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Text: 

Palette button 

 

Appearance of text button on the synoptic window 

 

Component properties: Text can be entered here. Click on the  button to select a font 

 

 

Status Components 

 

 

Square LED: 

Channels that can be 
connected 

- digital inputs 
- digital outputs 

Palette button 

 

Display of LED on the synoptic 
window 

 

The component colour is 
dependent on the channel status. 

Component properties: Click on a colour field in the colour frame to change the LED 

colour. The first field sets the colour when the channel value equals zero, the second sets 

the colour when the channel value equals 1. 
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Buttons components 

 

 

On/Off button: 

Channels that can be 
connected 

- Digital outputs 

Palette button 

 

Display of On/Off button on the 
synoptic window 

 

Component properties: The text displayed on the button can be changed in the text field, to 

change the font click on the  button. 

 

  



SIAM Industrial Fermentation Software  USER MANUAL 
 

 
www.bioreactors.eu  10 

Option button: 

Channels that can be 
connected 

- Digital inputs 
- Digital outputs 
- Analogue inputs 
- Analogue outputs 

Palette button 

 

Display of Options button on the 
synoptic window 

 

Component properties: The text displayed on the button can be changed in the text field, to 

change the font click on the  button. 

 

 

Calibration button: 

This function allows to calibrate the channels. 

Channels that can be 
connected 

- Analogue inputs 

Palette button 

 

Display of Calibration button on the 
synoptic window 

 

 

If a channel has only 2 lines in the calibration table, a 2-point calibration procedure can be 

carried out. The calibration parameters are calculated by the program and saved in the 

table. 

This allows a sensor to be calibrated with two reference solutions e.g. a pH electrode. 

(Caution: the program must not be in configuration mode. Click on the calibration button. A 

calibration window is displayed (Fig.34) Immerse the electrode in the first solution (e.g. pH 

4) and enter the effective value into the First Point box and click on Apply. Immerse the 

sensor in the second solution (e.g. pH 7), wait until the value is stable, enter the second 

value into the Second point box and click on Apply. The first value must always be less 

than the second. Close the window with the OK button. 
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Component properties: The text displayed on the button can be changed in the text field, to 

change the font click on the  button. 

 

 

Link button: 

The link button is used to link windows together (similar to hypertext links). If this button is 

pressed the linked window opens in the foreground. 

Channels that can be 
connected 

- none 

Palette button 

 

Display of Link button on the 
synoptic window 

 

Component properties: The linked window can be chosen from the list. The text displayed 

on the button can be changed in the text field, to change the font click on the  button. 
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Values components 

 

These components are designed to display the channel values. 

 

Analogue input 1: 

Channels that can be 
connected 

- analogue inputs 

Palette button 

 

Display of Link button on the 
synoptic window 

 

 

Component properties: To change the font click on the button. The background colour 

can be changed by clicking the Background colour button. 
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Analogue output 1: 

Channels that can be 
connected 

- analogue outputs 

Palette button 

 

Display of Link button on the 
synoptic window 

 

 

To enter a new value click on the input field. A second field is displayed into which the new 

target value can be entered. Press the return key to confirm the entry. If the value is 

outside the calibration limit it will not be accepted by the system. 

To close the field without change press the Escape key. The target value can be changed 

using the scrolling arrow. The change steps correspond to 1/1000 of the displayed interval. 

 

Component properties: To change the font click on the button. The background colour 

can be changed by clicking the Background colour button. 
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Vertical gauge: 

Channels that can be 
connected 

- analogue outputs 
- analogue inputs 

Palette button 

 

Display of vertical gauge button on 
the synoptic window 

 

Component properties: Click on the background colour field to change the colour. The 

display limit can also be entered. This limit can differ from the one used for the channel. 
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Horizontal gauge: 

Channels that can be 
connected 

- analogue outputs 
- analogue inputs 

Palette button 

 

Display of Horizontal gauge button 
on the synoptic window 

 

Component properties: Click on the Background colour 1 or 2 to change the gauge colour. 

The display limit can also be entered. This limit can differ from one used in other channels. 

 

 

Analogue inputs with option: 

Channels that can be 
connected 

- analogue inputs 

Palette button 

 

Display of Analogue inputs with option 
button on the synoptic window 

 

 

 

Curves components 
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Trend: 

Channels that can be 
connected 

- Up to 10 channels 
can be displayed as 
curves.  

Palette button 

 

Display of Trends on the synoptic 
window 

 

 

Channel choice: 

In the curve, the legend displays the channel name, the unit and the last value. Time 

relates to the last point entered. 

To change the scale, double click on the axis. A second field is displayed into which the 

minimum and maximum values can be entered.  

To select a channel click on the  button. This opens a in which the channel to be 

displayed can be selected together with one of four axes and the curve colour. 
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The  and  buttons reduce and enlarge the time interval and this  button displays 

a ruler. The channel values are displayed in the legend and the corresponding time is 

displayed above right. This button inactivates the automatic curve renewal mode. It is 

possible to return to this mode using the  button. 

 

 

Devices components 

 

These components are combinations of the simple components previously described. In this 

way you can create the user interface quicker than with single components.  

These objects no longer relate to channels, but to devices. 

 

Sample management: 

Samples can be managed with the virtual device, e.g. a concentration can be manually 

entered. 

 

Palette button 

 

Display of Sample on the synoptic 
window 

 

 

To take a sample click on the Sample button. A window is opened into which a sample 

description can be entered. The samples are automatically numbered by the system. Date 

and time are automatically entered. The numbering is reinitialised by clicking on the New 

Series button. 
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If the analysis results are known click on the Result button and a new window is opened in 

which the sample concentration can be entered. This value is also saved in the text file as 

long as the data saving is still running. 
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Run block button: 

Devices that can be 
connected: 

- Pulse function 
- Program 

Palette button 

 

Display of Run block on the synoptic 
window 

 

 

Reset block button: 

Devices that can be 
connected: 

- Balances 

Palette button 

 

Display of Reset block on the 
synoptic window 

 

 

 

Run and reset block: 

Devices that can be 
connected: 

- Profile 
- Timer 

Palette button 

 

Display of Run and reset block on 
the synoptic window 
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Simple controller block: 

Devices that can be 
connected: 

- On/Off controller 
- PID Controller 

Palette button 

 

Display of Simple controller on the 
synoptic window 

 

 

Gauge for controller block: 

Devices that can be 
connected: 

- On/Off controller 
- PID Controller 

Palette button 

 

Display of Gauge for controller block 
on the synoptic window 
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Tecon UR5 controller block: 

Devices that can be 
connected: 

- Tecon UR5 
controller 

Palette button 

 

Display of Tecon UR5 controller 
block on the synoptic window 

 

The controllers in this series are equipped with 2 PID controllers. For further details please 

refer the controller manual. 

 

MINIFOR Fermenter-bioreactor block: 

Devices that can be 
connected: 

- LAMBDA MINIFOR 
fermenter and 
bioreactor 

Palette button 

 

Display of MINIFOR fermenter-
bioreactor block on the synoptic 
window 
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Miscellaneous components 

 

 

Save in the text file: 

This option allows the channel values to be saved as a text file. Text files can be imported 

into most office programs e.g. word processors, spreadsheets, databases etc. 

Palette button 

 

Display of Text file block on the 
synoptic window 

 

 

To save channel values to a text file, click on the Config. button to open the 'Save data to 

text file' window. Select the File tab and enter the file name, then select the Channel tab 

and choose the channel for which the values need to be saved. Select the Time tab, if it is 

necessary to record the time interval between two entries and the time format. 

The data will be saved from the moment the On button is pressed and the file name will 

be displayed at the top. 

To stop saving the data click the On button once again, and [None] will be displayed at 

the top. If data storage is stopped, it is impossible to save further data. This applies 

particularly to offline values (sample management). 
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Common attributes 

When a component is displayed in the window there are only two further steps needed to 

make it functional. 

For components to be connected to channels: 

First step: to connect a channel, click on the component with the right mouse button and 

select Channel choice in the popup menu. 

Second step: to configure the selected channel, click on the component with the right mouse 

button and select Channel configuration in the popup menu. A dialog window is displayed, 

within which the channel can be configured. The fields are dependent on the channel, only 

the field Name is always available.  

For components to be connected to devices: 

First step: to connect a device, using the right mouse button click on the component and 

select Device choice in the popup menu. 

Second step: to configure the selected device, click on the component with the right mouse 

button and select Device configuration in the popup menu. A dialog window is opened, within 

which the channel can be configured. The fields are dependent on the device. 

The appearance of some of the components can be changed. Click on the component with 

the right mouse button and select Component properties in the popup menu. A window is 

opened showing the specific attributes (font colour size etc).These attributes can also be 

changed. These templates are also described in this chapter. 

 

Channel names 
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The first character must be a letter, but the following characters can also be numerals. 

Spaces or blanks are not allowed. Each name must be unique and two different channels 

may not have the same name. Words used in the programming language e.g. begin, if, etc. 

may not be used as names. 

 

CHANNELS 

The channels are the connections between the devices and the visual components. Some 

devices possess several channels in order to reduce the amount of work required to 

configure them, these devices have their own visual component. The various channels are 

connected automatically to each component.  

Channel configuration 

There are two different ways to configure a channel in configuration mode.  

1. In the Configuration menu click the command Device configuration and select the 

required device.  

 

 

A window will be displayed like below for the chosen device and then click on the 

button which corresponds to the channel required.  
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A window displaying the channel to be configured will open. For example: pO2 

channel. 
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2. Right click on the desired channel on the visual component and select Channel 

choice to select the channel and then channel configuration for configuring it. 

 

 

Each channel has a unique name e.g. Temperatur1, pH1 etc. This name can comprise a 

maximum of 20 characters, and must always start with a letter, but the following characters 

can also be numerals.  

Blanks are not allowed.  

Names which are already in use by other channel may not be repeated, and words which 

belong to computer programming languages (refer the chapter Visual components for more 

details) are also not allowed. 
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Digital inputs 

 

When all the field entries have been made click on OK to confirm and save the choice. If the 

program discovers a mistake, an error message is displayed. The Cancel button closes the 

window without saving the changes. 

 

Digital output 

 

The Inversion check box allows the output control to be reversed.  

Pressing the Channel control button in the group window switches the output to its lowest 

state (normally 0 volt). 

If the output is in a high state e.g. 24 volt, then channel control is switched off. 
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Analogue input 

 

Enter a name (as described above), followed by the measurement unit (maximum 5 

characters). The characters ó/ô ,ô-ô, and óÁô are not allowed. 

Before connecting the measuring device, check the maximum voltage and power output of 

the device, as too high a signal can damage the converter. 

Enter the limit values to be displayed into the group window. All values which are outside this 

range will be rounded up or down.  

Example: 

To make a flow rate measurement with a device that delivers 0 to 2 volts (0 to 6 l/hr) using a 

0 to10 volt input, enter values which correspond to 0 and 10 volts in the calibrations table: 0 

l/hr and 10/2*6 = 30 l/hr. Enter 0 as low and 6 as high limit values. The flow rate will only be 

displayed between 0 and 6 l/hr. 

When all the values have been entered click on OK to confirm and save the choice. The 

Cancel button closes the window without saving the changes. 
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Analogue output 

 

The fields are identical to those for an analogue input. 

Take care, when selecting an output, too high voltage or current could damage the device 
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Analogue input with calibration table 

 

Enter a name (as described above), followed by the measurement unit (maximum 5 

characters). The characters ó/ô, ô-ô, and óÁô are not allowed. 

Each channel can be specifically calibrated in the calibration table. If the electrical signal of 

the measurement is linear over the whole range, enter the values for the minimum and 

maximum of the signal. If the electrical signal is not linear over the whole range it can be 

made to fit with linear segments. The values are automatically sorted by clicking on OK. In 

order to convert the electrical signal to the right intensity the system carries out a 

linearization using 2 adjoining values. The values allowed are within the range {[-10000,-

0.001], 0, [+0.001, +10000]}. If the table contains only two lines the sensor can be 

retrospectively calibrated in the visualisations block using a two point procedure. 

Before connecting the measuring device, check the maximum voltage and power output of 

the device, as too high a signal can damage the converter. 

Enter the limit values to be displayed into the group window. All values which are outside this 

range will be rounded up or down. 

Example: 

To make a flow rate measurement with a device that delivers 0 to 2 volts (0 to 6 l/hr) using a 

0 to10 volt input, enter values which correspond to 0 and 10 volts in the calibrations table: 0 

l/hr and 10/2*6 = 30 l/hr. Enter 0 as low and 6 as high limit values. The flow rate will only be 

displayed between 0 and 6 l/hr. 

When all the values have been entered click on OK to confirm and save the choice. As long 

as the channel is not displayed in a group window the configuration can be changed. The 

Cancel button closes the window without saving the changes. 
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Analogue output with calibration table 

 

The fields are identical to those for an analogue input with calibration table. 

Take care while selecting an output as too high a voltage or current could damage the 

device. 

If the device does not react in a linear manner to changes in voltage or current, it is possible 

to change its operation with voltage or current = f (value) linear segments in the calibrations 

table as with analogue inputs. 

 

Channel options 

Digital inputs and outputs 

 

Select the level 1 or 2 at which an alarm should be given. Click on the Activate check box 

and the on OK to activate the alarm. 

 




















































